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Starting Bottled Water Business Plan (PDF)

The bottled water business industry has been steadily growing all across the world. This is due to a plethora of reasons which vary from place to place. For instance, big beverage companies have diversified into bottled water as one of their products over the years. Due to their wide reach it means bottled water has increasingly become more available than ever before. In some parts of the world the surge in mineral water businesses has been triggered by lack of access to clean and reliable water. Thus for drinking purposes or other related uses people there now prefer to use bottled water. Another interesting factor is global warming which has seen temperatures getting much higher in most parts of the world. This has resulted in the increased demand for commercially produced mineral water. Bottled water offers convenience and tends to taste better. Plus there is general perception that bottled water is safer. That is why starting a bottled water business can pay off immensely. All this is meant to show you that starting a bottled water business is a noble idea. This article will outline how to start a bottled water business, and the bottled water business plan (PDF, Word & Excel).
Market Research
The most important aspect you will look at here is finding out about existing players to draw insights from them. The market for bottled water is usually available anywhere but it is important to know of any competitors beforehand. Your focus will be to learn how they conduct their businesses paying particular attention to scale of operation, water sources, processing methods, target clients, pricing, marketing approaches and so on. Knowing these things will be central to your ultimate unique selling point. Things like packaging and pricing can put you over your competitors if well considered. As much as many players already exist and more are entering the bottled water business field, there is always a market segment that is unattended or insufficiently attended. Thus it essential to have a detailed mineral water business before you start.
Location, Premises And Equipment
In your choice of location of the purified water business, there are some considerations that you should make. Since any bottled water business entails the need to have a seamless distribution framework, it is a factor to consider. This means you must chose a location connected to strategic road networks for easy accessibility to clients and suppliers and the ultimate distribution of the bottled water. How secure is the location you are choosing – that is another important factor to consider. What about availability of water supply? Proximity to prospective clients, suppliers and human resources is also very vital. The mineral water business plan should include the costs of purchasing or leasing the premises.
The core thing you must work on from the onset is a water treatment plant. Some of the basic inclusions are bottling machines, filling machines, purification and treatment machines, labelling machines and a water source eg a borehole. The specific equipment you need will depend on the water purification methods you are going to use for your business. For example if you decide to purify water using reverse osmosis, that means you will require reverse osmosis machinery. Water storage tanks are also required. The costs of all the equipment should be catered for in your purified water business plan.
Types Of Bottled Water
There are different types of bottled water. In fact, there is still an evolution that is leading to the emergence of new types of bottled water. Your bottled water business plan should outline the type of water you are selling.
Mineral Water
This is water comprising of substantial amounts of dissolved minerals. Some of those minerals are calcium, sodium, and magnesium. Typically the water would have also gone through certain processes such as aeration or filtration. Note that there are strictly no chemical processes involved here. This water would have been sourced from some underground source. There must be ascertained and provable pollution-free qualities regarding the source. Most importantly, the water must have certain stipulated minerals in certain prescribed concentrations. That is what can earn it the label of ‘mineral water’.
Spring Water
This is water that would have been sourced from a spring. It is important to note that most of what is termed spring water is not from springs. It is usually a marketing gimmick and the water is often just tap water. Thus if you are going to sell spring water it must truly be from a spring. People often use ‘mineral water’ and ‘spring water’ interchangeably. This is because there are some similarities. Often time the distinction is that spring water is specifically sourced from a spring.
Purified Water
This is water that would have undergone a number of purification processes. These purification processes will be meant to get rid of chemical and solid contaminants. The original source of the water can be tap water or ground water. The common purification processes involved are filtration, reverse osmosis, and distillation, amongst others.
Sparkling Water
This can also be called soda water; it is also known as carbonated water. When you drink it feels as if you are drinking a fizzy drink. That is why some call it fizzy water. It is also commonly known as club soda. Sparkling water is a result of infusing water with carbon dioxide under pressure.
Flavoured Water
This is water that would have had natural or artificial flavors added to it. The flavors can be added as one or as a blend of several flavors. They are usually fruit flavors e.g. lemon, lime, orange, raspberry, mint, and blackberry, amongst others.
Staff And Management
This depends on the scale of operations and level of sophistication of your purified water business. Anything from 6 employees going up will do for a small-scale factory. The idea is there are pertinent areas that needed to be manned e.g. management, production, financial management, sales, distribution, and housekeeping amongst other areas. Your bottled water business plan should cater for the wages and employees of all your employees.
Customer Segmentation
Primary usage.
Customer segmentation for the bottled water production business is informed by several variables. For example, the primary usage of the bottled water can give an idea. Bottled water can be for everyday use, it can be sporting use, or it can be travel. These examples translate into customers segments with specific needs or preferences.
Type Of Bottled Water
Customer segments are also a function of the type of bottled water in question. For instance, in many places the most consumed type of bottled water is purified water. Consumption dynamics for the different types of bottled water helps you understand the customer segments.
Distribution Channel
People purchase their bottled water from different outlets. Maybe they purchase from supermarkets or shops. Zoning in on one you can know whether or not they buy in bulk. There will be much to learn about customer segments by looking into the various distribution channels.
Marketing Plan
Bottled water is the easiest to market. You just have to ensure your bottled water is properly branded. The best marketing strategy is to get your bottled water in front of as many people as possible. Avail it to commercial buildings, have it used at all sorts of events. You can target hospitality and catering outlets. Target wellness and fitness centres. Sporting events are also a strategic focus. Find ways to sell your purified water there or promote it through those locations. Sponsor worthy causes by donating free bottled water. Have it sold in supermarkets and shops. Consider traders especially street vendors, where applicable. These people can push your mineral water brand faster, far, and wide. In principle, have a wide distribution network so that people see your bottled water brand everywhere. Consider working with social media influencers and even celebrities if possible. Build a website and have active social media accounts to publicize your bottled water brand. Leverage on print and electronic media as well. A proper marketing strategy should be included in your bottled water business plan.
Approaches For Bottled Water Business
Regarding bottled water there two types of service providers, namely, large-scale and small or medium scale. The large scale ones tend to be companies already established like Coca Cola as an example. This can be an approach to take i.e. starting large-scale but this is not a smart move because it is costly. Most preferably you must start small or medium scale by targeting reasonably-sized markets e.g. small towns. Then depending on the performance of the bottled water business you scale up operations in due course. In order to push sales there is a unique strategy one can use for their bottled water. You can always have an eye out for big events such entertainment or corporate events. You go ahead and pitch up an idea to supply them with custom-labelled bottled water. Many people will jump onto that since it would give an exclusive flare to an event. In terms of sales you can also enter working agreements with big clients such as food outlets, hospitality spots (e.g. hotels, spars) and so on. This will be strategic in that you guarantee a steady and consistent flow of repeat purchases.
Do not be hesitant to start a mineral water business because it is not that difficult to start one. The demand for bottled water is very high and will always be so you can always carve out your own niche. Just adhere to strict codes of quality assurance and integrity – do not be one of those frauds who package unsafe water as bottled water yet it is neither treated nor purified. It is wise to take insurance cover and to make sure you have all the required certification or licenses that might be mandatory. Find out about this from local authorities, health inspection boards, environmental agencies and the like. Packaging and pricing are crucial but to top it off you must have a robust and active marketing strategy using all available channels.
Pre-Written Bottled Water Business Plan (PDF, Word And Excel): Comprehensive Version, Short Funding/Bank Loan Version and Automated Financial Statements
For an in-depth analysis of the bottled water manufacturing business, we encourage you to purchase our well-researched and comprehensive bottled water business plan. We introduced the business plans after discovering that many were venturing into the purified water business without enough knowledge and understanding of how to run the business, lack of understanding of the financial side of the business, lack of understanding of : the industry, the risks involved , costs and profitability of the business; which often leads to disastrous losses.
The StartupBiz Global mineral water business plan will make it easier for you to launch and run your water bottling plant business successfully, fully knowing what you are going into, and what’s needed to succeed in the business. This is a complete business plan for a packaged water business. It will be easier to plan and budget as you will be aware of all the costs involved in setting up and running the purified water business.
Uses of the Mineral Water Business Plan (PDF, Word And Excel)
The bottled water business plan can be used for many purposes including:
	Raising capital from investors/friends/relatives
	Applying for a bank loan
	Start-up guide to launch your bottled water business
	As a mineral water business proposal
	Assessing profitability of the bottled water business
	Finding a business partner
	Assessing the initial start-up costs so that you know how much to save
	Manual for current business owners to help in business and strategy formulation

Contents of the Bottled Water Business Plan (PDF, Word And Excel)
The business plan for purified water includes, but not limited to:
	Marketing Strategy
	Financial Statements (monthly cash flow projections, income statements, cash flow statements, balance sheets, break even analysis, payback period analysis, start-up costs, financial graphs, revenue and expenses, Bank Loan Amortization)
	Industry Analysis
	Market Analysis
	Risk Analysis
	SWOT & PEST Analysis
	Operational Requirements
	Operational Strategy
	Why some people in the bottled water business fail, so that you can avoid their mistakes
	Ways to raise capital to start your bottled water business

The purified water business plan package consists of 4 files
	Bottled Water Business Plan – PDF file (Comprehensive Version – 101 Pages)
	Bottled Water Business Plan – Editable Word File (Comprehensive Version – 101 Pages)
	Bottled Water Business Plan Funding/Bank Loan Version- Editable Word File (Short version for applying for a loan/funding – 48 pages)
	Bottled Water Business Plan Automated Financial Statements – (Editable Excel File)

The business plan can be used in any country and can be easily edited. The financial statements are automated. This implies that you can change eg the costs, salaries etc, and all the other financial statements will automatically adjust to reflect the change. 
Click below to download the Contents Page of the Bottled Water Business Plan (PDF)

Testimonial 6
I purchased a business plan from you, and I’m glad to inform you that I was able to get my loan, and I’m starting my poultry farming business on the 1 st of July. This was made possible because of your business plan. Thank you very much, you made my dream come true.
Testimonial 1
StartupBiz Global provided a very professional and comprehensive business plan which I used for my business. The business plan was easy to edit, and I was able to get the funding which I wanted. I highly recommend their business plans.
Testimonial 4
The business plan which I purchased from your website saved me TIME and MONEY! The layout of the business plan was excellent. The financial statements were detailed and easy for me to edit. I will come back to purchase another business plan soon.
Testimonial 5
I was able to understand the business side of farming because of your business plan. You did extensive research; the business plan was well prepared and fully detailed.  It made everything clear, and I have somewhere to start now. I am confident that I am going to succeed in my business because of the guidance from your business plan.
Testimonial 3
I was extremely lucky to come across StartupBiz Global. Their business plan exceeded my expectations, and most importantly I was able to secure a loan from my bank. Thank you guys, now my dreams are coming true!
Testimonial 2
Many thanks for your incredibly efficient service and thorough business plan. I am very impressed with the business plan. Before I bought the business plan, I tried to do my own business plan – it was such a nightmare and it turned out badly, also not to mention the stress it caused me. I wish I knew about your website earlier!
Testimonial 7
I found Startupbiz Global online when I was in desperate need of a business plan. I was overwhelmed by the quality of the business plan, it’s comprehensive and well researched! I did not have to wait to get the business plan, I got it instantly after payment. I highly recommend Startupbiz Global, and would happily use them again in the future.
Testimonial 8
Just wanted to say I am very happy with the business plan and I will gladly recommend your products, thank you very much and have a great day.
Get the Bottled Water Business Plan (PDF, Word And Excel)
Click Buy Now  below to purchase using Paypal, Credit Card, or Debit Card. After you have purchased, you will immediately see the download link for the business plan package on the screen. You will also immediately get an email with the business plan download link. The Pre-written business plan package (PDF, Word, and Excel) costs $30 only!

If you want to purchase multiple business plans at once then click here: Business Plans Store.
The business plan package is a zipped compressed file containing the PDF, Word and Excel documents. To open the package after downloading it, just right click, and select Extract All. If you have any problems in downloading and opening the files, email us on [email protected] and we will assist you.
We wish you the best in your bottled water business! Check out our collection of business plans  , and more business ideas .
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Bottled Water Business Plan Template
Written by Dave Lavinsky

Bottled Water Business Plan
Over the past 20+ years, we have helped over 1,000 entrepreneurs and business owners create business plans to start and grow their bottled water production companies. On this page, we will first give you some background information with regards to the importance of business planning. We will then go through a bottled water business plan template step-by-step so you can create your plan today.
Download our Ultimate Business Plan Template here >
What Is a Business Plan?
A business plan provides a snapshot of your bottled water company as it stands today, and lays out your growth plan for the next five years. It explains your business goals and your strategy for reaching them. It also includes market research to support your plans.
Why You Need a Business Plan
If you’re looking to start a bottled water business, or grow your existing business, you need a business plan. A business plan will help you raise funding, if needed, and plan out the growth of your bottled water company in order to improve your chances of success. Your business plan is a living document that should be updated annually as your company grows and changes.
Sources of Funding for Bottled Water
With regards to funding, the main sources of funding for a bottled water company are personal savings, credit cards, bank loans and angel investors. With regards to bank loans, banks will want to review your business plan and gain confidence that you will be able to repay your loan and interest. To acquire this confidence, the loan officer will not only want to confirm that your financials are reasonable, but they will also want to see a professional plan. Such a plan will give them the confidence that you can successfully and professionally operate a business. Personal savings and bank loans are the most common funding paths for bottled water businesses.
Finish Your Business Plan Today!
How to write a business plan for a bottled water company.
If you want to start a bottled water company or expand your current one, you need a business plan. Below we detail what should be included in each section of a business plan for a bottled water production company.
Executive Summary
Your executive summary provides an introduction to your business plan, but it is normally the last section you write because it provides a summary of each key section of your plan.
The goal of your Executive Summary is to quickly engage the reader. Explain to them the type of bottled water company you are operating and the status. For example, are you a startup, do you have a bottled water business that you would like to grow, or are you operating a bottled water production company in multiple markets?
Next, provide an overview of each of the subsequent sections of your plan. For example, give a brief overview of the bottled water industry. Discuss the type of bottled water business you are operating. Detail your direct competitors. Give an overview of your target customers. Provide a snapshot of your marketing plan. Identify the key members of your team. And offer an overview of your financial plan.  
Company Analysis
In your company analysis, you will detail the type of bottled water company you are operating.
For example, you might operate one of the following types of bottled water businesses:
	Purified or Distilled bottled water : this type of bottled water sells water that has been produced by distillation, deionization, or reverse osmosis.
	Sparkling bottled water: this type of bottled water contains carbon dioxide after the water has been treated. 
	Alkaline bottled waters: this type of bottled water includes increased hydrogen that causes greater hydration. Fitness enthusiasts are fans of this type of water as it provides more hydration than regular water. 

In addition to explaining the type of bottled water business you will operate, the Company Analysis section of your business plan needs to provide background on the business.
Include answers to question such as:
	When and why did you start the business?
	What milestones have you achieved to date? Milestones could include the number of customers served, number of positive reviews, reaching X amount of clients served, etc.
	Your legal structure. Are you incorporated as an S-Corp? An LLC? A sole proprietorship? Explain your legal structure here.

Industry Analysis
In your industry analysis, you need to provide an overview of the bottled water industry.
While this may seem unnecessary, it serves multiple purposes.
First, researching the bottled water industry educates you. It helps you understand the market in which you are operating. 
Secondly, market research can improve your strategy, particularly if your research identifies market trends.
The third reason for market research is to prove to readers that you are an expert in your industry. By conducting the research and presenting it in your plan, you achieve just that.
The following questions should be answered in the industry analysis sectio:
	How big is the bottled water industry (in dollars)?
	Is the market declining or increasing?
	Who are the key competitors in the market?
	Who are the key suppliers in the market?
	What trends are affecting the industry?
	What is the industry’s growth forecast over the next 5 – 10 years?
	What is the relevant market size? That is, how big is the potential market for your bottled water production business? You can extrapolate such a figure by assessing the size of the market in the entire country and then applying that figure to your local population.

Customer Analysis
The customer analysis section must detail the customers you serve and/or expect to serve.
The following are examples of customer segments: grocery stores, offices, schools, and gyms.
As you can imagine, the customer segment(s) you choose will have a great impact on the type of bottled water company you operate. Clearly, gyms would respond to different marketing promotions than grocery stores, for example.
Try to break out your target customers in terms of their demographic and psychographic profiles. With regards to demographics, include a discussion of the ages, genders, locations and income levels of the customers you seek to serve.
Psychographic profiles explain the wants and needs of your target customers. The more you can understand and define these needs, the better you will do in attracting and retaining your customers.
Finish Your Bottled Water Business Plan in 1 Day!
Don’t you wish there was a faster, easier way to finish your business plan?
With Growthink’s Ultimate Business Plan Template you can finish your plan in just 8 hours or less!
Competitive Analysis
Your competitive analysis should identify the indirect and direct competitors your business faces and then focus on the latter.
Direct competitors are other bottled water production companies. 
Indirect competitors are other options that customers have to purchase from that aren’t direct competitors. This includes online retailers, sports drinks such as Gatorade and Vitamin Water, and protein shakes. You need to mention such competition as well.
With regards to direct competition, you want to describe the other bottled water businesses with which you compete. Most likely, your direct competitors will be bottled water businesses located very close to your location.
For each such competitor, provide an overview of their businesses and document their strengths and weaknesses. Unless you once worked at your competitors’ businesses, it will be impossible to know everything about them. But you should be able to find out key things about them such as:
	What types of customers do they serve?
	What type of bottled water do they provide?
	What is their pricing (premium, low, etc.)?
	What are they good at?
	What are their weaknesses?

With regards to the last two questions, think about your answers from the customers’ perspective. And don’t be afraid to ask your competitors’ customers what they like most and least about them.
The final part of your competitive analysis section is to document your areas of competitive advantage. For example:
	Will you provide bottled water that tastes differently than the competition?
	Will you provide a type of bottled water that your competitors don’t offer?
	Will you provide better customer service?
	Will you offer better pricing?

Think about ways you will outperform your competition and document them in this section of your plan.  
Marketing Plan
Traditionally, a marketing plan includes the four P’s: Product, Price, Place, and Promotion. For a bottled water production company, your marketing plan should include the following:
Product : In the product section, you should reiterate the type of bottled water company that you documented in your Company Analysis. Then, detail the specific products you will be offering. For example, in addition to bottled water, will you provide electrolytes, different flavors, vitamins, and any other health products?
Price : Document the prices you will offer and how they compare to your competitors. Essentially in the product and price sub-sections of your marketing plan, you are presenting the services you offer and their prices.
Place : Place refers to the location of your bottled water company. Document your location and mention how the location will impact your success. For example, is your bottled water production business located in a busy retail district, an office setting, near gyms and fitness facilities, etc. Discuss how your location might be the ideal location for your customers.
Promotions : The final part of your bottled water marketing plan is the promotions section. Here you will document how you will drive customers to your location(s). The following are some promotional methods you might consider:
	Advertising in local papers and magazines
	Billboards and bus benches
	Social media marketing
	Local radio advertising

Operations Plan
While the earlier sections of your business plan explained your goals, your operations plan describes how you will meet them. Your operations plan should have two distinct sections as follows.
Everyday short-term processes include all of the tasks involved in running your bottled water business, including cleaning equipment, taking inventory, ordering new bottles and labels, placing labels on bottles, bottling each bottled water, marketing and promotions, and communicating with clients and customers.
Long-term goals are the milestones you hope to achieve. These could include the dates when you expect to sell your Xth bottled water, or when you hope to reach $X in revenue. It could also be when you expect to expand your bottled water business to a new city or location.  
Management Team
To demonstrate your bottled water business’ ability to succeed, a strong management team is essential. Highlight your key players’ backgrounds, emphasizing those skills and experiences that prove their ability to grow a company. 
Ideally you and/or your team members have direct experience in managing bottled water production companies. If so, highlight this experience and expertise. But also highlight any experience that you think will help your business succeed.
If your team is lacking, consider assembling an advisory board. An advisory board would include 2 to 8 individuals who would act like mentors to your business. They would help answer questions and provide strategic guidance. If needed, look for advisory board members with experience in managing a bottled water production business or marketing executive with experience in company branding and advertising.  
Financial Plan
Your financial plan should include your 5-year financial statement broken out both monthly or quarterly for the first year and then annually. Your financial statements include your income statement, balance sheet and cash flow statements.
Income Statement : an income statement is more commonly called a Profit and Loss statement or P&L. It shows your revenues and then subtracts your costs to show whether you turned a profit or not.
In developing your income statement, you need to devise assumptions. For example, will you start with a small selection of bottled water flavors and types and expand to offer a wider selection of bottled water ? And will sales grow by 2% or 10% per year? As you can imagine, your choice of assumptions will greatly impact the financial forecasts for your business. As much as possible, conduct research to try to root your assumptions in reality.
Balance Sheets : Balance sheets show your assets and liabilities. While balance sheets can include much information, try to simplify them to the key items you need to know about. For instance, if you spend $50,000 on building out your bottled water production business, this will not give you immediate profits. Rather it is an asset that will hopefully help you generate profits for years to come. Likewise, if a bank writes you a check for $50,000, you don’t need to pay it back immediately. Rather, that is a liability you will pay back over time.
Cash Flow Statement : Your cash flow statement will help determine how much money you need to start or grow your business, and make sure you never run out of money. What most entrepreneurs and business owners don’t realize is that you can turn a profit but run out of money and go bankrupt. 
In developing your Income Statement and Balance Sheets be sure to include several of the key costs needed in starting or growing a bottled water business:
	Cost of inventory 
	Cost of equipment and supplies
	Payroll or salaries paid to staff
	Business insurance
	Taxes and permits
	Legal expenses

Attach your full financial projections in the appendix of your plan along with any supporting documents that make your plan more compelling. For example, you might include your bottled water location lease or list of bottled water types you plan to sell.  
Putting together a business plan for your bottled water business is a worthwhile endeavor. If you follow the template above, by the time you are done, you will truly be an expert. You will really understand the bottled water industry, your competition, and your customers. You will have developed a marketing plan and will really understand what it takes to launch and grow a successful bottled water business.  
Bottled Water Business Plan FAQs
What is the easiest way to complete my bottled water business plan.
Growthink's Ultimate Business Plan Template allows you to quickly and easily complete a business plan for a bottle water production company.
Where Can I Download a Bottled Water Business Plan PDF?
You can download our Bottled Water business plan PDF  here. This is a business plan template you can use in PDF format.
What is the Goal of a Business Plan's Executive Summary?
The goal of your Executive Summary is to quickly engage the reader. Explain to them the type of water bottle business you are operating and the status; for example, are you a startup, do you have a water bottle business that you would like to grow, or are you operating a chain of water bottle businesses?
Don’t you wish there was a faster, easier way to finish your Bottled Water business plan?
OR, Let Us Develop Your Plan For You
Since 1999, Growthink has developed business plans for thousands of companies who have gone on to achieve tremendous success.   Click here to see how Growthink’s professional business plan consulting services can create your business plan for you.
Other Helpful Business Plan Articles & Templates


How to Start Mineral Water Plant Business in 10 steps
Do you want to start a mineral water business? Find here a detailed plan guide on how to start a mineral water plant business with costs, licenses, manufacturing process, machinery required, and more.
Packaged drinking water or mineral water manufacturing plant is a profitable business in India. Here in this post, find a detailed business plan guide on how to establish a small-scale package drinking water manufacturing plant with a reasonable investment.
Mineral water is purified water fortified with requisite amounts of minerals such as Barium, Iron, Manganese, etc. which can be absorbed by the human body. However, either you can obtain it from natural resources like springs and drilled wells or it is fortified artificially by blending and treating with mineral salts.
Packaged drinking water means water derived from any source of potable water and subjected to various treatments to meet the prescribed standard before being packed in a plastic or glass container. Water containing less than 250 ppm of total dissolved solids is defined as natural mineral water. Rising health awareness, an increase in tourism, and the easy availability of bottled water have increased the per capita consumption of bottled water in India.
Table of Contents
10 Steps to Start a Mineral Water Plant Business
1. understand the local market.
The first step before actually jumping into starting a mineral water plant is to know more about the local demand and the level of competition. It is advised to do detailed market research and collect the necessary information like who are the major players, market volume, pricing, opportunities, etc.
For example, you must have a plan to compete with the major players in the mineral water industry like Bisleri, Kinley, etc. In addition, you will also most probably face competition from local players. It is critical to understand your target consumers. Whether it’s households, offices, or retail outlets.
2. Create a Business Plan
It is a must to have a professionally drafted business plan document to launch a mineral water plant business. You must hire professionally competent people to write your business project plan.
If you are looking for funds from financial institutions, a business plan is a must-have document. All investors will ask for your project plan before deciding on whether to invest or not.
3. Finding a Reliable Water Source
One of the foundational steps in establishing a successful mineral water plant is selecting a reliable water source. Before finalizing a water source, conduct preliminary tests to assess its quality. It is strongly advised to consult with water quality experts or environmental engineers to interpret test results accurately.
Another important aspect is to assess the chemical composition of the water, looking for minerals and impurities. Perform microbial analysis to ensure the absence of harmful microorganisms.
Additionally, understand the local regulations regarding water extraction and usage. Obtain the necessary permits for water extraction from local authorities.
4. Arrange Funds
You will need a considerable amount of investment to start and run a mineral water plant business. If you are short on budget, it is advised to pitch for funds with local banks or private investors. There are various financial institutions that you can contact and pitch for funding in India. If you are unable to get the required funds from banks, reach alternative financial vendors for startup and working capital.
Read:   Best Business Loans for Small Businesses
5. Business Registration & License For Mineral Water Plant
In starting a small-scale mineral water plant, you must obtain different registrations and licenses from Government authorities. However, check your state’s law. Here we have listed some of the general criteria.
	First of all, register your business .
	Trade License from Municipal Authority
	Apply for Udyog Aadhaar MSME registration
	Additionally, apply for a Factory License
	Apply for GST registration number
	Licenses from the Food Safety and Standards Authority of India ( FSSAI )
	Get a Food Operator License
	BIS Certification. ISI Specification for packaged drinking water
	NOC from the Pollution Control Board
	Get your Business Name Trademarked.

6. Location and Infrastructure
Select a location with easy access to raw materials, a reliable water source, and transportation facilities. Set up a production facility with modern equipment for water purification, bottling, and packaging.
7. Mineral Water Manufacturing Plant Unit Setup
You will need to have a minimum covered area of 500 Sq Ft and an uncovered area of 500 Sq Ft to start a small-scale packaged drinking water or mineral water plant. However, the cost of the plant hugely depends on the packaging facility you want to get. Generally, packaged drinking water is available on the market in the form of 200 ml pouch packing, 500 ml bottles, 1-litre bottles, 2-litre bottles, 5-litre jars, and 20-litre drums.
According to the investment capacity and desired packaging, you must select the right type of plant. Additionally, you can go with a fully automatic plant. Otherwise, a semi-automatic plant is also very effective compared to a fixed-cost investment. We have listed here some of the major machinery and equipment.
	Alum Treatment Tanks
	Reverse Osmosis Plant
	Chlorination tanks made of S. Steel
	Sand filter
	Activated Carbon filter
	Micron filters
	Ultraviolet disinfectant system
	Electronic Doser for alum
	Electronic Doser for Chlorine
	Ozone Generator
	Raw and Purified water collection tanks with motor and accessories
	Automatic rinsing filling and capping machine
	Shrink wrapping machine for bottle
	Miscellaneous tools equipment, pipeline, etc.
	Laboratory testing and Quality Control, Microbiological instruments, etc.

8. Packaging and Branding
Choose appropriate packaging materials, such as PET bottles or jars. Develop an appealing brand identity and ensure compliance with labelling regulations.
9. Distribution Network
You need to establish partnerships with local retailers, supermarkets, and distributors. Also, consider setting up your retail outlets for direct consumer sales.
10. Marketing and Promotion
Create a website and leverage social media for marketing. Also, run promotional campaigns to create awareness, especially during the initial launch.
Mineral Water Manufacturing Plant Cost Synopsis:
Find here a sample investment chart of a small mineral water plant:
The actual cost of a mineral water plant project may change with different assumptions. You can modify the project capacity and project cost as per your requirements.
Frequently Asked Questions
How much does it cost to start a mineral water plant in india.
Depending on scale and location, you will need to invest approximately INR 10 lakhs to INR 20 lakhs.  Operational expenses will vary based on production volume and overheads.
Is the mineral water business profitable?
The mineral water business holds substantial potential for profitability. As lifestyles evolve, there is a heightened awareness of health, leading to an increased demand for safe and purified drinking water. In addition, consumers are making a preferential shift from traditional water sources to packaged mineral water.
What is the average profit margin in the bottled water industry?
Profit margins can vary. The industry average is typically between 10% and 20%. However, some premium brands or specialized products make higher margins.
What purification technologies are recommended for a mineral water plant?
Reverse Osmosis (RO) to remove impurities and contaminants. Use ultrafiltration processes for further purification and removal of microorganisms.
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Water purification and bottling business plan for starting your own business
Bottled water is one commodity consumed in all parts of the world, and of course, those in the business of producing bottled water are known to generate sales all year round if the company is well-managed. The economic downturn hardly affects the consumption of bottled water simply because it is a commodity that is as important as the air we breathe.
Production companies in the bottled water industry purify bottled water into plastic and glass bottles for consumption. The process involves use of a comprehensive business plan for bottled water and detailed franchise business planning .
If you plan on having a water purification and bottling business of your own, here is a purified drinking water business plan developed for Aqua Dreams. If you are confused about how to start a packaged drinking water business, this plan will provide you with all the details you need to know before going forward with your startup idea. 
The business plan for Aqua Dreams is as detailed as a business plan for Starbucks . Hence it is assured that it will answer all your questions regarding how to start a purified water business.
Executive Summary
2.1 the business.
Aqua Dreams will be a licensed and standard bottled water production company situated in an industrial area in Orleans, Massachusetts. We have been able to secure a long-term lease for a facility in a strategic location with an option of a long-term renewal on agreed terms and conditions favorable to us. The reason behind this successful execution is a well-thought-out water purification and bottling business plan .
2.2 Management of water purification and bottling business
While taking an entrepreneurial initiative, it is essential to ensure that all aspects of your business are coherent. Hence, you must prepare a unique bottled water business plan that helps you seek sufficient funding. 
Having said that, while writing a bottled water business proposal, you must analyze all the available resources. If you intend to raise loans, you should also study some business plans for banks because the process of getting loans can be exhaustive. 
2.3 Customers of water purification and bottling business
While thinking of how to start water bottle business, you must understand who your target market is. Including this detail in your water purification business plan will help you in subsequent planning. The recurring customers of Aqua Dreams are identified as:
	Restaurants and Canteens
	Event Planners

2.4 Business Target
Our vision is to establish a standard bottled water Production Company whose products will be sold in Orleans – Massachusetts, and throughout the United States of America and  Canada . There would be no compromise on the quality of the product, and complete transparency would be offered concerning our filtering processes.

Company Summary
3.1 company owner.
Aaron Finch will be the owner of Aqua Dreams. Aaron has strong leadership and organizational skills that he acquired while working at different water filtration plants since 2009. He graduated with a major in resource management from the University of Texas and researched this field ever since. He identified a lack of efficient purification systems in existing firms in the market and hence felt the need to introduce an innovative bottling water business plan.
3.2 Why the water purification and bottling business is being started
The bottled water production industry is profitable, and it is open for any aspiring entrepreneur to come in and establish their business. Aaron thought of coming up with a packaged drinking water business plan so that he doesn’t miss on any important aspect.
3.3 How the water purification and bottling business will be started
Step1: Planning for the business
Before setting up your business, looking into all the available resources and planning your way forward is essential. It gives you an idea of the availability of human resources and capital. If you are adding farm-related aspects to your business, it would be beneficial to also read out farmers market business plan before making a business plan for your startup.
Step2: Get Recognized
The next step is to be recognized by defining your business’s services and values. Having the proper business structure is very important to us at Aqua Dreams. Besides, producing healthy, portable, and well-packaged bottled water, we aim to impart perfect customer care service.
Step3: Offices 
The cooperate office of Aqua Dreams will be located in the industrial zone of Orleans. It will be a feasible location since it would grant easy access to resources. Consequently, the cost of acquiring production factors would be low. The market trends in this water purification business plan pdf can help you strategically choose your corporate office’s location. 
Step4: Online Presence
Living in an age of social media and digitalization, having a web presence is imperative for a company’s success. The website for Aqua Dreams would entail the company’s purification and bottling methods to educate the consumers about the sustainable processes we use.
Step5: Marketing
The last step is developing and executing a marketing plan to promote your services. In your business plan for bottled water , you must add marketing strategies that you will be using to reach out to the target customers. For diverse and unique advertisement ideas, research is imperative. You may need to visit several business operational models such as a liquor store business plan to gain an insight into the expectations of your target market.

Services of water purification and bottling business
Ideas to start your own bottled water business can be daunting and confusing. If you are new to the business and are unaware of the facilities to offer, you can refer to the services available at Aqua Dreams mentioned below:
	Bulk Purified water

The most preferred processes used for the purification process are reverse osmosis, deionization, and distillation. Aqua Dreams will use reverse osmosis systems as they remove up to 99% of organic substances and ions from the water. This process is discussed in detail in our water purification plant business plan.
	Still bottled water

This type of bottled water is the most often used to replace tap water. It has varying levels of dissolved minerals and does not contain added carbonation. In this bottling water business plan, we will list how much sales of this product were expected in a period lasting three years.
	Sparkling bottled water

Sparkling water, also known as seltzer, soda, or tonic water, is infused with carbon dioxide to create tons of bubbles and fizziness. It is often used as a healthy substitute for sugary sodas and other beverages because it is lower in calories and sugar. We will offer different flavors of the product to meet the expectations of our customers.
	Flavored bottled water

Flavored water is a beverage with added natural or artificial flavors, herbs, and sweeteners. Aqua Dreams will offer different options to its customers for a wider target market.
If you are new to the industry and are thinking how to start a water bottling plant, it is recommended that you go through this water bottling business plan pdf and learn about the technicalities involved.
Marketing Analysis of water purification and bottling business
Excellent work.
excellent work, competent advice. Alex is very friendly, great communication. 100% I recommend CGS capital. Thank you so much for your hard work!
In this water bottling plant business plan, you will find a detailed marketing analysis conducted by Aqua Dreams. This is the perfect water purification business plan sample for your reference if you are confused about how to start a water purification business.
5.1 Market Trends
Research conducted by IBIS World shows that the level of concentration in the purified drinking water business is modest in the USA. The top four players are expected to generate 65.5 percent of revenue. The industry is responsible for the employment of well over 14,360 people. Experts project the bottled water production industry to grow at a 4.0 percent annual rate.
5.2 Marketing Segmentation
While analyzing how to start a water purification business, you must investigate your target audience. Market segmentation is vital to understanding the scope of your filtered water business. If you don’t know who you will be interacting with, you can refer to the customer groups of Aqua Dreams mentioned below:

5.2.1 Hotels
The minibars you see in your hotel rooms are usually stocked with bottled water of all kinds, let it be still, sparkling, or flavored. Hence, Aqua Dreams will be supplying bottled water to different hotels on a contractual basis. Since they place large orders, their revenue would be the main reason behind the success of our water purification business. 
5.2.2 Restaurants 
Since sparkling water is also often used in cocktails and other drinks to create a fizzy sensation, restaurants in the city will be the primary customer group for this specific product for Aqua Dreams. Our products will also assist them with their purification systems installed in the kitchens.
5.2.3 Event Planners
Nowadays, instead of serving water in glasses, it is preferred to offer bottled water to the guests. Hence event planners are expected to procure bottled water from us and provide it to the customers they are dealing with.
5.2.4 Retailers
Carbonated and fizzy drinks are loved by almost everyone these days, which can be bad for their health. Our flavored water, supplied to retailers nationwide is relatively less unhealthy and therefore we expect to have great sales of it.
5.3 Business Target
	Start a bottled water delivery service based on a courier services business plan
	Have a customer satisfaction score of 93%
	Capture 30% market share within the first year of business
	Install two new purification plants in the next five years of operations 

5.4 Product Pricing
Our prices will conform to what is obtainable in the industry. We have put in place those business strategies that will help us run on low profits for six months.
Marketing Strategy of water purification and bottling business
Regardless of whether you are thinking of having a bottled water company business plan or a water purifying business plan, you need to have an effective marketing strategy. It would help you stand out amidst competition and capture market share. 
Aqua Dreams will use a robust set of marketing and sales strategies mentioned in this water bottle business plan pdf. Hence it would be helpful for you to read it thoroughly if you are wondering how to start a packaged drinking water business.
6.1 Competitive Analysis
	The services at Aqua Dreams would be supervised by water purification experts who have insights worth 5+ years of experience.
	Sustainable practices such as environmentally friendly purification systems will be employed at Aqua Dreams.
	Calorie Check will be done thoroughly in our flavored bottled water.
	The introductory prices offered by Aqua Dreams would be lower than the market rates without compromising on the quality of services.

6.2 Sales Strategy
	Introduce our bottled water by sending introductory letters to hotels, water merchants, and restaurants.
	Advertise in local directories.
	Use social media platforms such as Facebook and Instagram for sponsored ads.

6.3 Sales Monthly

6.4 Sales Yearly

6.5 Sales Forecast

Personnel plan of water purification and bottling business
The average cost involved in a bottled water production water business plan is similar to that in a donut shop business plan .
It is important to account for different kinds of costs to forecast financial returns accordingly. These costs also include the salaries of employees at the purification plants. To give you an idea of average salaries in the market, the salaries of our employees are quoted in this purified water business plan.
7.1 Company Staff
While thinking of water business ideas, the following are the positions you would essentially recruit for:
	1 Plant Manager
	1 Operations Manager
	5 Production Assistants
	1 Marketing Officer
	3 Delivery Drivers
	1 QA Engineer

7.2 Average Salary of Employees
Financial plan of water purification and bottling business.
A sole focus on increasing sales does not ensure that your business has become successful. For generating profits, you need to do a thorough analysis of your water company profile and estimate the operations’ capacity for your business accordingly.
In your financial plan, you must identify when and how to cover your investment amount with the earned profits. Moreover, you should evaluate the business projections and ratios to assess how the financial trajectory of your enterprise will go in the coming years. These assessments are important to highlight in your business plan for a water purification plant because they help investors decide whether to fund your bottled water startup or not. Besides, they help you direct your efforts to achieve your business goals.
If you don’t know how to conduct a financial analysis, you can refer to this water bottle business plan pdf.
Here we’re providing a business plan used by Aqua Dreams for you to use as a reference.
8.1 Important Assumptions
8.2 break-even analysis.

8.3 Projected Profit and Loss
8.3.1 profit monthly.

8.3.2 Profit Yearly

8.3.3 Gross Margin Monthly

8.3.4 Gross Margin Yearly

8.4 Projected Cash Flow

8.5 Projected Balance Sheet
8.6 business ratios.
	Is water bottling a profitable business?

A bottled water plant is profitable, provided a strategic business plan is in place. The average bottled water profit margin ranges between 25-30% for small and medium-scale water plants. It can be as high as 60% for large bottle production. Hence, the question “is bottled water business profitable” really depends on your scale of operations and management.
	How do I start a water purification business?

You can make a business plan and execute it in a set time frame. The most common mistake made when starting a new business is neglecting to write up a business plan. A good purified water business plan establishes a framework and a roadmap for your water purification business. If you try starting a bottled water business without a well-defined plan, your venture might not get successful.
	Is packaged drinking water business profitable?

The profit margin in the mineral water business is highly dependent on your products and location. This business can be profitable if you research what is in demand in the market and come with up unique sales ideas to let your customers know about you.
	How much does it cost to manufacture a bottle of water?

The cost of manufacturing a bottle of water differs from business to business based on the technology that is being used. Moreover, the scale and production level will also affect the cost incurred during manufacturing.
To get an idea of how you can cut costs, you can see a butcher shop business plan . It is generally assumed that mass production leads to lower manufacturing costs and in turn prices.
Download Water Purification and Bottling Business Plan Template in pdf
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Free Download
Water Purification Business Plan Template
Download this free water purification business plan template, with pre-filled examples, to create your own plan..
Or plan with professional support in LivePlan. Save 50% today
Available formats:

What you get with this template
A complete business plan.
Text and financials are already filled out and ready for you to update.
	SBA-lender approved format

Your plan is formatted the way lenders and investors expect.
Edit to your needs
Download as a Word document and edit your business plan right away.
	Detailed instructions

Features clear and simple instructions from expert business plan writers.

All 100% free. We're here to help you succeed in business, no strings attached.
Get the most out of your business plan example
Follow these tips to quickly develop a working business plan from this sample.
1. Don't worry about finding an exact match
We have over 550 sample business plan templates . So, make sure the plan is a close match, but don't get hung up on the details.
Your business is unique and will differ from any example or template you come across. So, use this example as a starting point and customize it to your needs.
2. Remember it's just an example
Our sample business plans are examples of what one business owner did. That doesn't make them perfect or require you to cram your business idea to fit the plan structure.
Use the information, financials, and formatting for inspiration. It will speed up and guide the plan writing process.

3. Know why you're writing a business plan
To create a plan that fits your needs , you need to know what you intend to do with it.
Are you planning to use your plan to apply for a loan or pitch to investors? Then it's worth following the format from your chosen sample plan to ensure you cover all necessary information.
But, if you don't plan to share your plan with anyone outside of your business—you likely don't need everything.

See why 1.2 million entrepreneurs have written their business plans with LivePlan
More business planning resources

How to Create a Business Plan Presentation

How to Write a Business Plan for Investors

Business Plan Template

How to Write a Business Plan

Simple Business Plan Outline

How to Start a Business With No Money

10 Qualities of a Good Business Plan

Industry Business Planning Guides
Download your template now
Need to validate your idea, secure funding, or grow your business this template is for you..
	Fill-in-the-blank simplicity
	Expert tips & tricks

We care about your privacy. See our privacy policy .
Not ready to download right now? We'll email you the link so you can download it whenever you're ready.
Download as Docx
Download as PDF

Finish your business plan with confidence
Step-by-step guidance and world-class support from the #1 business planning software

Discover the world’s #1 plan building software

Sample Water Purification Plant Business Plan
Water purification company business plan pdf sample.
The water purification business is one of the most lucrative businesses of the twenty-first century. Considering that water is a basic human need, then you can understand why water purification is a lucrative business.
The global water purification business is worth over $60 billion (U.S dollar). Global corporations are making moves for market share in the industry.
Because of the basic nature of water, access to good, healthy water is a necessity. Science and technology have come up with water purification methods and technology to ensure access to safe and clean water for human use and consumption.
Here is a sample business plan for starting a water treatment plant.
In this article, we shall be guiding you on how to write a water purification business plan. Regardless of whether your business is s startup or an already existing business, you will surely benefit from this business plan guide.
In writing a business plan for a water purification business, there is a required format to be followed. The format for a water purification business should contain the following parts and chapters.
	The Introduction or The Industry Overview
	The Executive Summary
	Risk and Strength Analysis
	The Market Analysis
	The Competition
	The Sales and Marketing Strategy
	Financial Analysis and Forecast
	Sustainability and Expansion Strategy

To prepare a worthwhile business plan, the above-listed parts of the business plan shall be discussed.
The introduction or industry overview of the water purification business plan will discuss the global trend in the water purification business.
To be stated also is the role of the growth in human population and global need for clean, good and potable water.
A deep knowledge and understanding of the water purification business should be discussed in the introduction of the business plan stating knowledge of and an understanding of the water purification industry.
On the executive summary of the business plan, the business structure of the company should be discussed.
Also to be contained in the executive summary chapter is details about the company and its people.
To be in this section also is a statement of the company’s vision statement and mission statement. These statements should be clearly stated in the business plan.
Also to be in this section is the roles and responsibilities of the company’s core officers and executives.
The risk and strength analysis of the business plan will provide information on the risks which the water purification business faces.
It will also provide information on the strengths of your business. One of the risks to consider is government regulation and interference.
This section also discusses the weaknesses of the business such as lack of qualified workers. The strength of the business which can be stated in this section of the plan is its superior marketing plan.
Market analysis of the water purification business plan will deal with the understanding of the market.
This includes the target market for your company. The target market for the company could include multinationals and blue chip companies, banks and other financial institutions, manufacturing companies, hotels, schools and the government.
Residential homes and apartments are also viable, though not as viable as the other market segments. You can also state your understanding of trends in the market.
Because of the lucrative nature of the water purification business, the business is a very competitive one.
This part of the business plan should provide information on the state of competition in the industry.
You should also be able to mention who the competitions in the water purification business are. Your competitions are the other well-known water purification businesses.
On this part of the water purification business plan, you should provide information on the marketing strategy to be used by your business in gaining market share from the competition.
A solid tactic to adopt would be to present your business as a reliable brand in water purification and making use of social media as a marketing tool.
You should also discuss your pricing and how you intended to use a cost-effective approach to attract sales.
Financial analysis and forecast are very important for the success of the business. This chapter of the business plan should detail your financial position, such as your current cash flow and expenses.
You should also provide information on sources of funding for the business. To be contained in this section also includes revenue and financial projections for the future of the business.
This chapter of the business plan will detail how you intend to grow and expand the business.
Your sustainability strategy involves efforts to ensure that your brand remains relevant in the market. On the other hand, your expansion strategy deals with your strategies for growth such as expanding your target market.
This chapter of the water purification business plan provides a summary of the business plan and your remarks. In writing the summary, you can also make a highlight of the key decision points contained in the business plan.
Related posts:
	Sample Plant Nursery Business Plan
	Sample Tire Recycling Plant Business Plan
	Sample Cassava Processing Plant Business Plan
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Sachet Water Production Business Plan [Sample Template]
By: Author Tony Martins Ajaero
Home » Business Plans » Food Sector » Food Processing
Are you about starting a sachet water production company? If YES, here is a complete sample sachet water production business plan template & feasibility report you can use for FREE .
You may not find a sachet water company in developed countries because they may not welcome the idea of a sachet water business. However, in developing countries like Nigeria , it has become a thriving industry. If you are interested in the bottled water production business and you don’t have the capacity to go into the business, then one of your best bet is to start a sachet water production business.
Although a sachet water production company is easy to set up, but you would need to do proper ground work if you must make headway in this line of business. This is because there are loads of sachet water production and distribution companies scattered all across Nigeria and you are expected to compete with them for the available market.
A Sample Sachet Water Production Business Plan Template
1. industry overview.
Sachet or bottled water as the case maybe is one commodity that is consumed in all parts of the world and of course those that are in the business of producing sachet or bottled water, are known to generate sales year in year out if the business is well managed.
As a matter of fact, economic downturn hardly affects the consumption of sachet or bottled water because water is as important as the air we breathe.
Production companies in the sachet and bottled water industry basically purify and bottle water into plastic and glass bottles for consumption. The bottled and sachet water are properly packaged (sealed or capped) and labeled accordingly before being sold to the general public.
Companies in this industry usually have an assortment of water offerings such as spring water, mineral water, sparkling water and flavored water in a range of sizes and prizes. Players in this industry are also involved in ice manufacturing.
It is common to find big corporations who are into production of soft drinks, food and beverages engage in the production of bottled water.
Research conducted by IBISWorld shows that in the united states of America, the level of concentration in the Bottled Water Production industry is modest, as the top four players are expected to generate 65.5 percent of the industry revenue.
Given the heavy bulk weight of industry products and the relatively low value per unit sold, bottled water production is generally taken on by large companies with major economies of scale and heavy investments in transportation.
While the majority of bottled water production is performed as one of many activities within the corporate portfolios of international food and beverage companies, the remaining portion of the industry’s production is performed through small-sized local players.
The Bottled Water Production industry is a thriving sector of the economy of the United States of America and they generate over $5 billion annually from more than 565 registered and licensed bottle water production companies scattered all around the United States of America.
The industry is responsible for the employment of well over 14,360 people. Experts project the bottle water production industry to grow at a 4.0 percent annual rate. The Coca Cola Company, Nestle and Pepsi Co are the world leaders in the bottled water industry; they have the lion market share in the United States of America and in most countries of the world.
Despite the fact that there are big corporations who are into the production of bottled water, the fact remains that starting a small – scale sachet water production business has minimal barriers to entry, with low startup capital. Most players in the sachet water production industry are small to medium size establishments that cater to the local community.
With this kind of business, if you want to start on a small scale, you can choose to start servicing your local community. All you would need are contacts, packaging, networking and good marketing and customer service skills. However, if you intend starting it on a large scale, then you should consider spreading beyond your local community to the state and even national level.
Over and above, the bottled water production industry that sachet water is a part of is indeed a profitable industry and it is open for any aspiring entrepreneur to come in and establish his or her business.
2. Executive Summary
Glittering® Sachet Water Production Company is a licensed and standard sachet water production company that will be located in Ikeja, Lagos – Nigeria. We have been able to secure a long-term lease for a facility in a strategic location with an option of a long-term renewal on  agreed terms and conditions that are favorable to us.
The facility has government approval for the kind of business we want to run, it is easily accessible and we are deliberate about that to facilitate easy movement of raw materials and finished products.
We are in the sachet water production business to engage in purifying and packaging sachet water. We are also in business to make profit and at the same to give our customers value for their money; we want to give people and businesses who patronize our sachet water the opportunity to be part of the success story of Glittering® Sachet Water Production Company.
We are aware that there are several large and small scale sachet and bottled water production companies whose products can be found everywhere in Nigeria, which is why we spent time and resources to conduct our feasibility studies and market survey so as to enable us locate the business in an area that will support the growth of the business.
We ensured that our facility is easy to locate and we have mapped out plans to develop a wide distribution network for wholesalers all around Ikeja and environs. Glittering® Sachet Water Production Company will ensure that all our customers (wholesale distributors) are given first class treatment whenever they visit our Depot/Plant.
We have a CRM software that will enable us manage a one on one relationship with our customers (wholesale distributors) no matter how large the number of our customer base may grow to. We will ensure that we get our customers involved when making some business decisions that will directly or indirectly affect them.
Glittering® Sachet Water Production Company is family business that will be owned by Mark Bassey Hector and his immediate family members. Bassey Hector who is the Chief Executive Officer of the Company is Graduate of Micro Biology (B.Sc.) and he holds a Master’s Degree in Business Management (MBA) from the University of Lagos.
He has over 5 years’ experience working in related industry as a senior manager prior to starting Glittering® Sachet Water Production Company. He will be working with a team of professionals to build the business and grow it to enviable height.
3. Our Products and Services
Glittering® Sachet Water Production Company is going to operate a standard and licensed sachet water production company whose products will not only be sold in Ikeja – Lagos State but also throughout Lagos State and neighboring states.
We are in the sachet water production business to make profits and also to give our customers value for their money. These are some of the products that we will be offering;
	Sachet water
	Bottled water (in the nearest future)
	Dispensable water (in the nearest future)

4. Our Mission and Vision Statement
	Our vision is to establish a standard sachet water Production Company whose products will be sold not only in Ikeja, but also throughout Nigeria.
	Our mission is to establish a standard and world class sachet water Production Company that in our own capacity will favorably compete with leaders in the industry such as Nestle Foods, Coca Cola Company, and Pepsi Co et al.

Our Business Structure
Glittering® Sachet Water Production Company is a business that is established with the aim of competing favorably with other leading sachet and bottled water brands in Nigeria. This is why we will put the right structure in place that will support the kind of growth that we have in mind while setting up the business.
We will ensure that we only hire people that are qualified, honest, hardworking, customer centric and are ready to work to help us build a prosperous business that will benefit all our stakeholders.
As a matter of fact, profit-sharing arrangement will be made available to all our senior management staff and it will be based on their performance for a period of five years or more depending how fast we meet our set target. In view of that, we have decided to hire qualified and competent hands to occupy the following positions;
	Chief Executive Officer (Owner)

Plant Manager
	Sales and Marketing Officers
	Accountants/Cashiers

Distribution Truck Drivers
	Production/Machine Operators

5. Job Roles and Responsibilities
Chief Executive Officer – CEO (Owner):
	Increases management’s effectiveness by recruiting, selecting, orienting, training, coaching, counseling, and disciplining managers; communicating values, strategies, and objectives; assigning accountabilities; planning, monitoring, and appraising job results; developing incentives; developing a climate for offering information and opinions; providing educational opportunities.
	Creates, communicates, and implements the organization’s vision, mission, and overall direction – i.e. leading the development and implementation of the overall organization’s strategy.
	Responsible for fixing prices and signing business deals
	Responsible for providing direction for the business
	Responsible for signing checks and documents on behalf of the company
	Evaluates the success of the organization
	Responsible for overseeing the smooth running of the sachet water production plant
	Part of the team that determines the quantity of sachet water that are to be produced per day
	Maps out strategy that will lead to efficiency amongst workers in the plant
	Responsible for training, evaluation and assessment of plant workers
	Ensures that the steady flow of both raw materials to the plant and easy flow of finished products through wholesale distributors to the market
	Ensures operation of equipment by completing preventive maintenance requirements; calling for repairs.
	Responsible for overseeing the smooth running of HR and administrative tasks for the organization
	Serves as the quality control officer
	Ensures that the plant meets the expected safety and health standard at all times

Sales and Marketing Manager
	Manages external research and coordinate all the internal sources of information to retain the organizations’ best customers and attract new ones
	Model demographic information and analyze the volumes of transactional data generated by customer purchases
	Identifies, prioritizes, and reaches out to new partners, and business opportunities et al
	Develops, executes and evaluates new plans for expanding increase sales
	Documents all customer contact and information
	Helps to increase sales and growth for the company

Accountant/Cashier
	Responsible for preparing financial reports, budgets, and financial statements for the organization
	Provides managements with financial analyses, development budgets, and accounting reports; analyzes financial feasibility for the most complex proposed projects; conducts market research to forecast trends and business conditions.
	Responsible for financial forecasting and risks analysis
	Performs cash management, general ledger accounting, and financial reporting
	Responsible for developing and managing financial systems and policies
	Responsible for administering payrolls
	Ensures compliance with taxation legislation
	Handles all financial transactions for the organization
	Serves as internal auditor for the organization

Production Workers/Machine Operators:
	Responsible for purifying and sealing of water
	Assist in packaging and loading bags of sachet water into distribution trucks
	Any other duty as assigned by the plant manager
	Assists in loading and unloading bags of sachet water
	Maintains a logbook of their driving activities to ensure compliance with federal regulations governing the rest and work periods for operators
	Keeps a record of vehicle inspections and make sure the truck is equipped with safety equipment
	Assists the transport and logistics manager in planning their route according to a delivery schedule
	Local-delivery drivers may be required to sell products or services to stores and businesses on their route, obtain signatures from recipients and collect cash
	Transport finished goods and raw materials over land to and from manufacturing plants or retail and distribution centers
	Inspect vehicles for mechanical safety issues and perform preventative maintenance
	Complies with truck driving rules and regulations (size, weight, route designations, parking, break periods etc.) as well as with company policies and procedures
	Collects and verify delivery instructions
	Reports defects, accidents or violations

6. SWOT Analysis
We are not unaware that there are several sachet and bottled water production companies both large and small all-around Lagos State which is why we are following the due process of establishing a business so as to compete favorable with them.
We know that if a proper SWOT analysis is conducted for our business, we will be able to position our business to maximize our strength, leverage on the opportunities that will be available to us, mitigate our risks and be welled equipped to confront our threats.
Glittering® Sachet Water Production Company employed the services of an expert HR and Business Analyst with bias in startup businesses to help us conduct a thorough SWOT analysis and to help us create a Business model that will help us achieve our business goals and objectives.
This is the summary of the SWOT analysis that was conducted for Glittering® Sachet Water Production Company;
Part of what is going to count as positives for Glittering® Sachet Water Production Company is the vast experience of our management team, we have people on board who are highly experienced and understand how to grow a business from the scratch to becoming a national phenomenon.
So also, our large distribution network and of course our excellent customer service culture will definitely count as a strong strength for the business.
A major weakness that may count against us is the fact that we are a new sachet water production company and we don’t have the financial capacity to engage in the kind of publicity that we intend giving the business especially when big names like Nestle Foods, The Coca Cola Company and Pepsi Co et al are already determining the direction of the market both in Nigeria and in the globe.
	Opportunities:

The opportunities for sachet water production companies are enormous. This is due to the fact that sachet water is far cheaper than bottled water and people can easily afford it.
As a result of that, we were able to conduct a thorough market survey and feasibility studies so as to position our business to take advantage of the existing market for sachet water and also to create our own new market. We know that it is going to require hard work, but we are determined to achieve it.
We are quite aware that just like any other business, one of the major threats that we are likely going to face is economic downturn and unfavorable government policies . Another threat that may likely confront us is the arrival of a new sachet or bottled water production company in same location where ours is located.
7. MARKET ANALYSIS
	Market Trends

If you are conversant with the trend in the sachet/bottled water production industry, you will agree that there are competitions in different stages of the industry. That is competitions amongst bigger corporations such as Pepsi Co, Coca Cola Company and Nestle et al; and also competitions amongst smaller and medium scale bottled water production companies.
Most bottled water companies are leveraging on creativity in terms of packaging and marketing to continue to stay afloat in the industry. One creativity approach that is common is ensuring that their bottled water conforms to the appropriate PH – level.
As a matter of fact, it is common to find sachet or bottled water production companies especially medium scale and small scale bottled water companies labeling their sachet or bottled water for specific occasions to meet the demand of their clients.
For example, a client that is celebrating his or her birthday may strike an agreement with a bottled water company to specially label the bottled water that will be served in the occasion to conform with the occasion.
Lastly, another trend in the bottled water production industry is the adoption of eco – friendly approach towards the production and packaging of sachet and bottled water. As a matter of fact, the industry’s adoption of eco-friendly practices will likely persuade environmentally conscious consumers to buy its products, while increasing operators’ efficiency.
8. Our Target Market
When it comes to selling sachet or bottled water, there is indeed a wide range of available customers. In essence, our target market can’t be restricted to just a group of people, but all those who reside in our target market locations.
In view of that, we have conducted our market research and we have ideas of what our target market would be expecting from us. We are in business to engage in wholesale distribution and to retail sachet water to the following groups of people;
	Restaurants and Canteens
	Event Planners, Parties and Corporate Functions
	Everybody in our target market location

Our Competitive Advantage
A close study of the sachet cum bottled water production industry reveals that the market has become much more competitive over the last decade.
As a matter of fact, you have to be highly creative, customer centric and proactive if you must survive in this industry. We are aware of the stiff competition and we are prepared to compete favorably with other sachet and bottled water production companies in Ikeja and throughout Lagos – Nigeria.
Glittering® Sachet Water Production Company is launching a standard sachet water brand that will indeed become the preferred choice of residents of Ikeja and every other location where our sachet water will be retailed.
Part of what is going to count as competitive advantage for Glittering® Sachet Water Production Company is the vast experience of our management team; we have people on board who understand how to grow a business from the scratch to becoming a national phenomenon.
So also, our large national distribution network and of course our excellent customer service culture will definitely count as a strong strength for the business.
Lastly, our employees will be well taken care of, and their welfare package will be among the best within our category in the bottled water industry, meaning that they will be more than willing to build the business with us and help deliver our set goals and achieve all our aims and objectives.
We will also give good working conditions and commissions to freelance sales agents that we will recruit from time to time.
9. SALES AND MARKETING STRATEGY
	Sources of Income

Glittering® Sachet Water Production Company is established with the aim of maximizing profits in the sachet and bottled water production industry in Lagos State and environs and we are going to go all the way to ensure that we do all it takes to sell our products to a wide range of customers. Glittering® Sachet Water Production Company will generate income by selling the following products;
10. Sales Forecast
One thing is certain when it comes to the sachet and bottled water production business, if your water is well packaged and branded and if your production plant is centrally positioned and easily accessible, you will always attract sales and that will sure translate to increase in revenue for the business.
We are well positioned to take on the available market in Ikeja – Lagos State and every city where our sachet water will be sold and we are quite optimistic that we will meet our set target of generating enough profits from the first six months of operation and grow the business and our clientele base.
We have been able to critically examine the sachet and bottled water production industry and we have analyzed our chances in the industry and we have been able to come up with the following sales forecast. The sales projection is based on information gathered on the field and some assumptions that are peculiar to startups in Ikeja – Lagos State.
	First Fiscal Year: N1.2 Million
	Second Fiscal Year: N2.5 Million
	Third Fiscal Year: N4 Million

N.B : This projection was done based on what is obtainable in the industry and with the assumption that there won’t be any major economic meltdown and there won’t be any major competitor offering same products and customer care services as we do within the same location. Please note that the above projection might be lower and at the same time it might be higher.
	Marketing Strategy and Sales Strategy

Before choosing a location for Glittering® Sachet Water Production Company, we conducted thorough market survey and feasibility studies in order for us to be able to penetrate the available market in our target locations.
We have detailed information and data that we were able to utilize to structure our business to attract the number of customers we want to attract per time and also for our products to favorable compete with other leading brands in Lagos State.
We hired experts who have good understanding of the sachet and bottled water production industry to help us develop marketing strategies that will help us achieve our business goal of winning a larger percentage of the available market in Ikeja and other locations in Lagos State.
In other to continue to be in business and grow, we must continue to sell our sachet water to the available market which is why we will go all out to empower our sales and marketing team to deliver our corporate sales goals. In summary, Glittering® Sachet Water Production Company will adopt the following sales and marketing approach to sell our sachet water;
	Introduce our sachet water brand by sending introductory letters to residents, restaurants and other stakeholders all around Lagos State
	Open our sachet water production company with a party so as to capture the attention of residents who are our first targets
	Engage in roadshows in targeted communities from time to time to sell our sachet water
	Advertise our products in community based newspapers, local TV and radio stations
	Leverage on the internet to promote our sachet water brands
	Engage in direct marketing and sales
	Encourage the use of Word of mouth marketing (referrals)

11. Publicity and Advertising Strategy
Despite the fact that our sachet water production plant is a standard one that can favorably compete with other leading brands, we will still go ahead to intensify publicity for our product. We are going to explore all available means to promote Glittering® Sachet Water Production Company.
Glittering® Sachet Water Production Company has a long – term plan of going into bottled water production and distributing, which is why we will deliberately build our brand to be well accepted in Ikeja – Lagos State before venturing out.
As a matter of fact, our publicity and advertising strategy is not solely for selling our products but to also effectively communicate our brand. Here are the platforms we intend leveraging on to promote and advertise Glittering® Sachet Water Production Company;
	Sponsor relevant community programs
	Leverage on the internet and social media platforms like Instagram, Facebook, twitter, et al to promote our sachet water brand
	Engage in roadshows from time to time in targeted communities
	Distribute our fliers and handbills in target areas
	Ensure that our sachet water is well branded and that all our staff members wear our customized clothes, and all our official cars and distribution vans are customized

12. Our Pricing Strategy
When it comes to pricing for sachet water, there are two sides to the coin. We are aware of the pricing trend in the sachet and bottled water production industry which is why we have decided to produce various sizes of sachet water.
In view of that, our prices will conform to what is obtainable in the industry but we will ensure that within the first 6 to 12 months our products are sold a little bit below the average price. We have put in place business strategies that will help us run on low profits for a period of 6 months; it is a way of encouraging people to buy into our water brand.
	Payment Options

The payment policy adopted by Glittering® Sachet Water Production Company is all inclusive because we are quite aware that different customers prefer different payment options as it suits them but at the same time, we will ensure that we abide by the financial rules and regulation in Nigeria.
Here are the payment options that Glittering® Sachet Water Production Company will make available to her clients;
	Payment with cash
	Payment via online bank transfer
	Payment via mobile money

In view of the above, we have chosen banking platforms that will enable our clients pay us without any difficulty. Our bank account numbers will be made available on our website and promotional materials so that it will be easier for members to pay for products purchased.
13. Startup Expenditure (Budget)
Starting a standard sachet water production company is capital intensive. The bulk of the startup capital will be spent on leasing or acquiring a facility and also in purchasing water purifying and packaging equipment. Asides from that, you are expected to purchase distribution trucks, pay of your employees and also pay utility bills.
These are the key areas where we will spend our startup capital;
	The Fee for registering the business in Nigeria – N15,000
	Legal expenses for obtaining licenses and permits as well as the accounting services (software, P.O.S machines and other software) – N30,000
	Marketing promotion expenses for the grand opening of Glittering® Sachet Water Production Company – N15,000
	Cost for hiring Business Consultant – N20,000
	Insurance (general liability, workers’ compensation and property casualty) coverage at a total premium – N20,000
	Cost for payment of rent for 12 month and renovation inclusive – N250,000
	The cost for purchasing and installing water purifying machines – N250,000
	Operational cost for the first 3 months (salaries of employees, payments of bills et al) – N150,000
	The cost for start-up inventory (supply of well – branded sachets, water purifying chemicals and fueling et al) – N150,000
	The Cost for purchasing a distribution truck – N800,000
	Cost for store equipment (cash register, security, ventilation, signage) – N10,000
	The cost of launching a website – N25,000
	The cost for our opening party – N70,000
	Miscellaneous – N50,000

We would need an estimate of N2.5 million to successfully set up a medium scale but standard sachet water production business in Ikeja – Lagos, Nigeria.
Generating Startup Capital for Glittering® Sachet Water Production Company
No matter how fantastic your business idea might be, if you don’t have the required money to finance the business, the business might not become a reality. Finance is a very important factor when it comes to starting a standard sachet water production business.
Glittering® Sachet Water Production Company is a family business that is owned and financed by Mr. Bassey Hector and his immediate family members. They do not intend to welcome any external business partners which is why he has decided to restrict the sourcing of the startup capital to 3 major sources.
These are the areas we intend generating our startup capital;
	Generate part of the startup capital from personal savings
	Source for soft loans from family members and friends
	Apply for loan from my Bank

N.B: We have been able to generate about N500,000 ( Personal savings N400,000 and soft loan from family members N100,000 ) and we are at the final stages of obtaining a loan facility of N2 Million from our bank (micro – finance bank).
All the papers and documents have been signed and submitted, the loan has been approved and any moment from now our account will be credited with the amount.
14. Sustainability and Expansion Strategy
The future of a business lies in the number of loyal customers they have, the capacity and competence of the employees, their investment strategy and their business structure. If all of these factors are missing from a business, then it won’t be too long before the business closes shop.
One of our major goals of starting Glittering® Sachet Water Production Company is to build a business that will survive off its own cash flow without injecting finance from external sources once the business is officially running.
We know that one of the ways of gaining approval and winning customers over is to retail our sachet water and other products a little bit cheaper than what is obtainable in the market and we are well prepared to survive on lower profit margin for a while.
Glittering® Sachet Water Production Company will make sure that the right foundation, structures and processes are put in place to ensure that our staff welfare are well taken of. Our company’s corporate culture is designed to drive our business to greater heights and training and retraining of our workforce is at the top burner.
As a matter of fact, profit-sharing arrangement will be made available to all our management staff and it will be based on their performance for a period of three years or more. We know that if that is put in place, we will be able to successfully hire and retain the best hands we can get in the industry; they will be more committed to help us build the business of our dreams.
Check List/Milestone
	Business Name Availability Check: Completed
	Business Registration: Completed
	Opening of Corporate Bank Accounts: Completed
	Opening Mobile Money Accounts: Completed
	Opening Online Payment Platforms: Completed
	Application and Obtaining Tax Payer’s ID: In Progress
	Application for business license and permit: Completed
	Purchase of Insurance for the Business: Completed
	Leasing of facility and construction of standard sachet/bottled water plant: In Progress
	Conducting Feasibility Studies: Completed
	Generating capital from family members and friends: Completed
	Applications for Loan from the bank: In Progress
	Writing of Business Plan: Completed
	Drafting of Employee’s Handbook: Completed
	Drafting of Contract Documents and other relevant Legal Documents: In Progress
	Design of The Company’s Logo: Completed
	Printing of Packaging and Promotional Materials: In Progress
	Recruitment of employees: In Progress
	Purchase of the needed furniture, racks, shelves, computers, electronic appliances, office appliances and CCTV: In progress
	Creating Official Website for the Company: In Progress
	Creating Awareness for the business both online and around the community: In Progress
	Health and Safety and Fire Safety Arrangement (License): Secured
	Opening party/launching party planning: In Progress
	Establishing business relationship with vendors – wholesale suppliers: In Progress
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Mineral Water Plant Project Business Plan, Profit Margin & Cost Estimation

Do you want to start your own mineral water plant business in India? If yes, then you have come to right place..! In this article, I am sharing step by step process of starting a mineral water plant or packaged dring water plant in India. Demand of packaged drinking water is growing exponentially in small towns and cities in India. This is evergreen business and there is place for everyone who want to step into this opportunity. Investment required in this business depends upon many factors, few of them are given below :-
	The production capacity of the plant
	The place in which plant is being setup
	Transportation cost
	Type of water used as source or feed water and its chemistry
	The type of plant and production capacity per hour – such as bottled, pouches, jar, etc.

There is room for everyone in this business. You can setup small plant with the investment of Rs 15 lakhs or you can go for big plant with high production capacity in 75 lakhs.
Below is a list of important points which I will discuss in this article:-
	Difference between mineral water plant and packaged drinking water plant
	What are the documents and licenses required to run this business in India
	Machinery required for mineral water plant and machinery cost
	How to setup your plant and cost estimation
	Water treatment process
	Packaging and suppy
	Profit margin in this business
	How to grow your business – Further opportunities

Let’s get started –
What is the difference between packaged water and mineral water plant.
Before getting into detailed business plan, you need to understand the difference between packaged drinking water plant and mineral water plant. Many people do not know the differences and get confused at the very beginning of their business venture.
Packaged Drinking Water or Bottled water Plant – In this plant, we process borewell water and we reduce the TDS(Total Dissolved Solid) in borewell water with the help of RO process i.e Reverse Osmosis Process. Packaged drinking water does not contains any minerals.
Mineral Water Plant – In this plant, we use water from natural sources like spring water and mountain water. These waters contain mineral which is beneficial for human consumption. In mineral water plant we process and add minerals to water if required. Minerals found in mineral water are sodium, calcium, magnesium, potassium, etc.
In this article I will share information for setting up of packaged drinking water plant which is also known as bottled drinking water plant.
What type of licenses are required?
The following licenses and documents are required for setting up a bottled water plant in India:
	Small scale industry registration certificate
	AOA and MOA of the business
	ISI certification from Bureau of Indian Standards ( BIS )
	Pollution control certificate from local pollution board office
	Feed water test report from laboratory
	Pest control certificate

Steps involved in packaged driking water production
	Identify source of raw water – This is the first step in which you will decide about the source of water which you will use in production of packaged drinking water. The source of water could be bore well water, muncipal supply or other sources in which treatment is possible.
	Store raw water – The next process is to store raw water in raw water storage tank with the help of pumping system. Submercible pump could be used in case of bore well water.
	Water treatment system – In water treatment process, we use clorine dosing system, water softening process, reverse osmosis (RO), UV sterilization and Ozone disinfection.
	Testing of water – In this process we test purified water in inhouse water testing laboratory. In the laboratory, water is tested for micro biological and chemical parameters. We will discuss about type of laboratory requiment later in this article.
	Purified water storage (Bottles/Jars/Pouch) – Production machinery is required to blow blottles and store purified water in it. Similarly, machines are available for storage in jars and pouches.

Process Involved in purification of raw water (Technical Aspects)
	Coagulation process – This is the first step in which we add Alum chemical in raw water to remove impurities. The Alum chemical produces positive charges which stick together with negative charge of the particals and forms large particles which can be removed easily. After coagulation process, water is allowed to settle for 1 hour.
	Reverse Osmosis – With the help of RO process we remove dissolved impurities such as salts from water.
	Chlorination of water – This process is used to kill bacterias and other micro organism with the help of bubbling chlorine gas in chlorination tank.
	Sand filteration – The water is then passed through sand filters to remove undissolved impurities.
	Carbon filteration de-chlorination – After sand filteration process, we then pass water through carbon filter which removes odour and colour. Dechlorification also takes place using carbon filters.
	Packing and bottling – Packing and bottling is done with the help of machines.

Packaged Drinking Water Plant Cost Estimation
From the above table, we come to know that cost of machines for starting mineral water plant is around 15 lakhs rupess. Apart from machinery, you will need a proper location for plant installation and some basis furniture.
After the installation of plant, you have make a proper business plan for production of bottled drinking water. That business plan will include following details –
	Salary and wages for staffs
	Working capital per month
	Production target
	Other expensenses in raw materials if any

Production Capacity & Profit Margin Calculation
Total Production of your plant will depend on how many hours you will work i.e number of shifts assuming that 1 shift is of 8 hours. Suppose you will 2 shifts i.e 16 hours. Therefore, you can produce 8000 bottles in 8hrs.
Profit Margin Calculation –
Now we will calcute yearly profit in this business:-
	Daily production is 8000 bottles i.e yearly production will be 8000 X 365 = 2920000 Bottles
	No. Of crates – assuming one crate has 12 bottles – 2920000/12 = 24333 crates yearly
	Selling price of one crate will be – Rs 80 per crate
	Total turnover – 80 x 24333 = Rs 1 Crore 94 lakhs
	Total profit = Turnover – cost of production

Now you have to calculate the cost of production of 24333 crates. The cost of production will include salary to staff, raw materials expenses, electricity usage, laboratory expenses and other expenses.
The cost of production of 24333 crates of packaged drinking water will come around 12 lakhs monthly. So annual cost of production will be 1 crore 44 Lakhs
Total profit = 1 crore 94 lakhs – 1 crore 44 lakhs = 50 lakhs Annualy
Branding and Marketing
As the demand of packaged drinking water is increasing rapidly, you have to capture the market and start promoting your brand as soon you start production. Include marketing expenses in your business plan and use it accordingly.
The process of setting up a mineral water plant typically includes obtaining a business license, renting or purchasing factory space, buying equipment, and hiring staff. Other considerations may include obtaining permits, conducting market research, and creating a marketing plan.
The demand for mineral water is difficult to quantify due to the numerous factors that can affect it. Some of these factors include the price of alternative beverages, weather conditions, and health trends. In general, though, the demand for mineral water tends to be fairly high, especially in developed countries where clean water is readily available.
The challenges in setting up a mineral water plant include: 1. Finding a source of water that is high in mineral content. 2. Ensuring that the water is properly filtered and treated before bottling. 3. Creating a market for the mineral water.
The type of management required for a mineral water plant depends on the size and scope of the operation. For a small operation, management may only need to be concerned with daily production and quality control. For a larger operation, management may also need to be involved in marketing, distribution, and finance.
The cost of setting up a mineral water plant in India depends on a number of factors, including the scale of production, the raw materials used, the equipment used, and the location of the plant. A small-scale mineral water plant may cost as little as Rs. 2 lakhs, while a large-scale plant may cost as much as Rs. 20 crore.
There are several marketing strategies that can be used for a mineral water plant. One strategy is to focus on the health benefits of drinking mineral water. This can be done through advertising and using health professionals to promote the benefits of drinking mineral water. Another strategy is to focus on the taste and quality of the mineral water. This can be done through using celebrity endorsements, special events, and social media campaigns.
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Standard Pure Water Bottled Water Business Plan In Nigeria PDF & 2022 Financial Report

Our Updated sachet & Bottle water business plan is regularly updated to meet the current market prices and can also be used for loans and grants application. Setting up the ever profitable bottled/sachet water company can be very lucrative business in Nigeria since man need for water is almost infinite and contrary to what some might think, you can actually start a sachet & Bottle water business in Nigeria with capital ranging from 2.5 Million Naira for a small size company or above 10 Million Naira for a bigger production capacity. TABLE OF CONTENT 1.0 EXECUTIVE SUMMARY 1.1 OUR VISION: 1.2 MISSION 2.0 BUSINESS DESCRIPTION: 2.1 INDUSTRY DESCRIPTION: 2.3 REQUIREMENTS 2.4 BUSINESS RISK / MITIGATION 2.5 REQUIREMENT FOR ENTERING INTO THE BUSINESS 3.0 DEFINITION OF MARKET 3.1 MARKET SEGMENTATION 3.2 MAJOR COMPETITORS 3.3 COMPETITIVE ADVANTAGE 4.0 PRODUCT DESCRIPTION 4.1 EQUIPMENT/MACHINE 4.2 MAJOR RAW MATERIALS 4.3 PRODUCTION PROCESS 4.4 PRODUCT UNIQUENESS 5.0 ORGANIZATION AND MANAGEMENT: 5.1 ORGANIZATION STRUCTURE 5.3 STAFF SALARIES 6.0 MARKETING STRATEGIES 7.0 FINANCIAL MANAGEMENT/ANALYSIS CONCLUSION GET OUR BOTTLED / SACHET PURE WATER BUSINESS PLAN IN NIGERIA PDF, Call 09052016587 To place order, pay N10,000 to GTBank (Guaranty Trust Bank) Account Name – Jeweh Kelvin Account No – 0125961425 After payment text your name, your e-mail address & payment details to 09052016587 and immediately we will send a copy of the Bottled /Pure Water Business Plan in Nigeria (PDF) to your email box.
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Bottled Water Business Plan

Your bottled water business will give your clients plenty of hydration whether it uses; filtered, distilled, or natural spring water. Thus are you ready to hydrate people and start your business out of it? But before starting it you will need careful planning.
Need help writing a business plan for your bottled water business? You’re at the right place. Our bottled water business plan template will help you get started.

Free Business Plan Template
Download our free business plan template now and pave the way to success. Let’s turn your vision into an actionable strategy!
	Fill in the blanks – Outline
	Financial Tables

How to Write A Bottled Water Business Plan?
Writing a bottled water business plan is a crucial step toward the success of your business. Here are the key steps to consider when writing a business plan:
1. Executive Summary
An executive summary is the first section planned to offer an overview of the entire business plan. However, it is written after the entire business plan is ready and summarizes each section of your plan.
Here are a few key components to include in your executive summary:
Introduce your Business:
Start your executive summary by briefly introducing your business to your readers.
Market Opportunity:
Products and services:.
Highlight the bottled water services you offer your clients. The USPs and differentiators you offer are always a plus.
Marketing & Sales Strategies:
Financial highlights:, call to action:.
Ensure your executive summary is clear, concise, easy to understand, and jargon-free.
Say goodbye to boring templates
Build your business plan faster and easier with AI
Plans starting from $7/month

2. Business Overview
The business overview section of your business plan offers detailed information about your company. The details you add will depend on how important they are to your business. Yet, business name, location, business history, and future goals are some of the foundational elements you must consider adding to this section:
Business Description:
Describe your business in this section by providing all the basic information:
Describe what kind of bottled water company you run and the name of it. You may specialize in one of the following bottled water businesses:
	Natural spring water
	Purified water
	Mineral water
	Artesian water
	Functional water
	Describe the legal structure of your bottled water company, whether it is a sole proprietorship, LLC, partnership, or others.
	Explain where your business is located and why you selected the place.

Mission Statement:
Business history:.
If you’re an established bottled water service provider, briefly describe your business history, like—when it was founded, how it evolved over time, etc.
Future Goals
This section should provide a thorough understanding of your business, its history, and its future plans. Keep this section engaging, precise, and to the point.
3. Market Analysis
The market analysis section of your business plan should offer a thorough understanding of the industry with the target market, competitors, and growth opportunities. You should include the following components in this section.
Target market:
Start this section by describing your target market. Define your ideal customer and explain what types of services they prefer. Creating a buyer persona will help you easily define your target market to your readers.
Market size and growth potential:
Describe your market size and growth potential and whether you will target a niche or a much broader market.
Competitive Analysis:
Market trends:.
Analyze emerging trends in the industry, such as technology disruptions, changes in customer behavior or preferences, etc. Explain how your business will cope with all the trends.
Regulatory Environment:
Here are a few tips for writing the market analysis section of your bottled water company business plan:
	Conduct market research, industry reports, and surveys to gather data.
	Provide specific and detailed information whenever possible.
	Illustrate your points with charts and graphs.
	Write your business plan keeping your target audience in mind.

4. Products And Services
The product and services section should describe the specific services and products that will be offered to customers. To write this section should include the following:
Describe your products & services:
Mention the paralegal services your business will offer. This list may include services like,
	Single-serve bottles
	Multipack bottles
	Premium & specialty bottles
	Water filtration
	Water delivery services
	Customized bottles

Describe the health benefits
Quality measures, additional services.
In short, this section of your bottled water plan must be informative, precise, and client-focused. By providing a clear and compelling description of your offerings, you can help potential investors and readers understand the value of your business.
5. Sales And Marketing Strategies
Writing the sales and marketing strategies section means a list of strategies you will use to attract and retain your clients. Here are some key elements to include in your sales & marketing plan:
Unique Selling Proposition (USP):
Define your business’s USPs depending on the market you serve, the equipment you use, and your unique services. Identifying USPs will help you plan your marketing strategies.
Pricing Strategy:
Marketing strategies:, sales strategies:, customer retention:.
Overall, this section of your bottled water production business plan should focus on customer acquisition and retention.
Have a specific, realistic, and data-driven approach while planning sales and marketing strategies for your bottled water business, and be prepared to adapt or make strategic changes in your strategies based on feedback and results.
6. Operations Plan
The operations plan section of your business plan should outline the processes and procedures involved in your business operations, such as staffing requirements and operational processes. Here are a few components to add to your operations plan:
Staffing & Training:
Operational process:, technologies & equipment:.
Include the list of equipment and machinery required for bottled water, such as water treatment equipment, bottling equipment, quality control equipment, packaging & labeling equipment, etc.
Adding these components to your operations plan will help you lay out your business operations, which will eventually help you manage your business effectively.
7. Management Team
The management team section provides an overview of your bottled water business’s management team. This section should provide a detailed description of each manager’s experience and qualifications, as well as their responsibilities and roles.
Founders/CEO:
Key managers:.
Introduce your management and key members of your team, and explain their roles and responsibilities.
Organizational structure:
Compensation plan:, advisors/consultants:.
Mentioning advisors or consultants in your business plans adds credibility to your business idea.
This section should describe the key personnel for your bottled water business, highlighting how you have the perfect team to succeed.
8. Financial Plan
Your financial plan section should provide a summary of your business’s financial projections for the first few years. Here are some key elements to include in your financial plan:
Profit & loss statement:
Cash flow statement:, balance sheet:, break-even point:.
Determine and mention your business’s break-even point—the point at which your business costs and revenue will be equal.
Financing Needs:
Be realistic with your financial projections, and make sure you offer relevant information and evidence to support your estimates.
9. Appendix
The appendix section of your plan should include any additional information supporting your business plan’s main content, such as market research, legal documentation, financial statements, and other relevant information.
	Add a table of contents for the appendix section to help readers easily find specific information or sections.
	In addition to your financial statements, provide additional financial documents like tax returns, a list of assets within the business, credit history, and more. These statements must be the latest and offer financial projections for at least the first three or five years of business operations.
	Provide data derived from market research, including stats about the industry, user demographics, and industry trends.
	Include any legal documents such as permits, licenses, and contracts.
	Include any additional documentation related to your business plan, such as product brochures, marketing materials, operational procedures, etc.

Use clear headings and labels for each section of the appendix so that readers can easily find the necessary information.
Remember, the appendix section of your bottled water manufacturer business plan should only include relevant and important information supporting your plan’s main content.
The Quickest Way to turn a Business Idea into a Business Plan
Fill-in-the-blanks and automatic financials make it easy.

This sample bottled water business plan will provide an idea for writing a successful bottled water plan, including all the essential components of your business.
After this, if you still need clarification about writing an investment-ready business plan to impress your audience, download our bottled water business plan pdf .
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How to Write a Business Plan Outline
Frequently asked questions, why do you need a bottled water business plan.
A business plan is an essential tool for anyone looking to start or run a successful bottled water business. It helps to get clarity in your business, secures funding, and identifies potential challenges while starting and growing your business.
Overall, a well-written plan can help you make informed decisions, which can contribute to the long-term success of your bottled water company.
How to get funding for your bottled water business?
There are several ways to get funding for your bottled water business, but self-funding is one of the most efficient and speedy funding options. Other options for funding are:
	Bank loan – You may apply for a loan in government or private banks.
	Small Business Administration (SBA) loan – SBA loans and schemes are available at affordable interest rates, so check the eligibility criteria before applying for it.
	Crowdfunding – The process of supporting a project or business by getting a lot of people to invest in your business, usually online.
	Angel investors – Getting funds from angel investors is one of the most sought startup options.

Apart from all these options, there are small business grants available, check for the same in your location and you can apply for it.
Where to find business plan writers for your bottled water business?
There are many business plan writers available, but no one knows your business and ideas better than you, so we recommend you write your bottled water business plan and outline your vision as you have in your mind.
What is the easiest way to write your bottled water business plan?
A lot of research is necessary for writing a business plan, but you can write your plan most efficiently with the help of any bottled water business plan example and edit it as per your need. You can also quickly finish your plan in just a few hours or less with the help of our business plan software .
Can a good bottled water business plan help me secure funding?
Indeed. A well-crafted bottled water business plan will help your investors better understand your business domain, market trends, strategies, business financials, and growth potential—helping them make better financial decisions.
So, if you have a profitable and investable business, a comprehensive business plan can certainly help you secure your business funding.
What's the importance of a marketing strategy in a bottled water business plan?
Marketing strategy is a key component of your bottled water business plan. Whether it is about achieving certain business goals or helping your investors understand your plan to maximize their return on investment—an impactful marketing strategy is the way to do it!
Here are a few pointers to help you understand the importance of having an impactful marketing strategy:
	It provides your business an edge over your competitors.
	It helps investors better understand your business and growth potential.
	It helps you develop products with the best profit potential.
	It helps you set accurate pricing for your products or services.
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Upmetrics is the #1 business planning software that helps entrepreneurs and business owners create investment-ready business plans using AI. We regularly share business planning insights on our blog. Check out the Upmetrics blog for such interesting reads. Read more

Plan your business in the shortest time possible
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Bottled Water Business Plan Template [Updated 2024]

I. Executive Summary
This Section's Contents
Business Overview
Products served, customer focus, management team, success factors, financial highlights.
[Company Name], located in [insert location here] is a new bottled water company that focuses on providing high-quality, filtered bottled water. The company uses proprietary technology to filter its water and provide the best tasting water in the industry. The company also plans to distribute their bottled water to retail locations throughout the United States.
[Company Name] will provide a variety of different types of bottled water. Products will include mineral water, spring water, purified water, sparkling water, artesian well water and alkaline water.
Products are focused on providing healthy and nutritious beverage options for an individual to achieve maximum hydration.
[Company Name] will primarily serve the residents within a 5 to 10-mile radius of our location. The demographics of these residents are as follows:
	195,203 residents
	Average income of $46,000
	49.3% married
	40.5% in Mgt./Professional occupations
	Median age: 43 years

[Company Name] is led by [Founder’s Name], a local dietician who runs a private practice in [location]. She has studied nutrition, diet, and exercise and has been running a successful practice for over 20 years. She has written books, journal articles, and presented at numerous health conferences. [Founder] has studied the effects of properly bottled water for health benefits and has developed a proprietary system for filtering water while maintaining all of the crucial vitamins and minerals of well and tap water.
[Company Name] is uniquely qualified to succeed due to the following reasons:
	The company will be providing a valuable product to those seeking the most beneficial water source for their active lifestyles.
	The company is in a high-volume area that is near to hospitals, schools, gyms, and recreation centers.
	The management team has a track record of success in the nutrition industry and is a proven expert in the field.
	The pricing model is formulated to be slightly higher than the competition as it is a higher-quality product, but low enough that customers will perceive value when consuming.
	[Company Name] will be sold in most grocery stores and convenience stores.

[Company Name] is seeking total funding of $225,000 to open its bottled water manufacturing and distribution company.
	Factory design/build-out: $100,000
	Equipment and supplies: $75,000
	Working capital: $50,000 to pay for marketing, salaries, and lease costs until [Company Name] reaches break-even

Comments are closed.
Bottled Water Business Plan Home I. Executive Summary II. Company Overview III. Industry Analysis IV. Customer Analysis V. Competitive Analysis VI. Marketing Plan VII. Operations Plan VIII. Management Team IX. Financial Plan


Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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	Starting Bottled Water Business Plan (PDF)
Starting Bottled Water Business Plan (PDF) By StartupBiz Global / Business Ideas, Business Plans, Manufacturing Industry The bottled water business industry has been steadily growing all across the world. This is due to a plethora of reasons which vary from place to place.




	PDF PUBLIC DRINKING WATER SUPPLY SYSTEM
success is. The Business Plan is a methodical approach to answering those questions. A Business Plan is intended to show that a water system can remain viable. The definition of a viable drinking water system is one that is: • Self sustaining; • Has the financial and institutional commitment of the system owner and operators,- customers, and




	Bottled Water Business Plan Template
Written by Dave Lavinsky Bottled Water Business Plan Over the past 20+ years, we have helped over 1,000 entrepreneurs and business owners create business plans to start and grow their bottled water production companies. On this page, we will first give you some background information with regards to the importance of business planning.




	Bottled Water Business Plan [Sample Template]
1. Industry Overview Bottled water is one commodity that is consumed in all parts of the world and of course those that are in the business of producing bottled water are known to generate sales year in year out if the business is well - managed.




	PDF Business Plan 2020
WSUP Water & Sanitation for the Urban Poor Water, sanitation and hygiene: a critical issue for cities Water and sanitation are essential for healthy lives. People need water and sanitation to live, work and prosper. Yet today, 2.3 billion people lack access to basic sanitation, and nearly 1 billion lack access to even basic water services.1




	How to Start Mineral Water Business in 10 Steps
10 Steps to Start a Mineral Water Plant Business. 1. Understand the Local Market. The first step before actually jumping into starting a mineral water plant is to know more about the local demand and the level of competition.




	Water Purification Business Plan Example
Water Purification Business Plan Start your own water purification business plan H2O Industries Executive Summary H20 Industries, Inc. (H20 Industries) provides the service of ion exchange portable tanks. This is the process of purifying water for industrial purposes.




	Business Plan For Water Production
Business Plan for Water Production - Free download as Word Doc (.doc / .docx), PDF File (.pdf), Text File (.txt) or read online for free. Strategy for water commerce




	Business Plan of Mineral Water Plant
204253906-Business-Plan-of-Mineral-Water-Plant.docx - Free download as Word Doc (.doc / .docx), PDF File (.pdf), Text File (.txt) or read online for free. Scribd is the world's largest social reading and publishing site.




	Sample Bottled Water Production Business Plan
By Olaoluwa March 20, 2023 BOTTLED WATER COMPANY BUSINESS PLAN PDF SAMPLE Starting a commercial bottling business is an excellent way to make money as an entrepreneur. Commercial bottling business is one business that most entrepreneurs overlook because the business is not as popular as the poultry, tailoring, or home decoration business.




	PDF BUSINESS PLANNING GUIDELINES
management level so as to come up with the draft final Business Plan to be submitted to the Board. The Business Plan approval process shall be as stipulated in section 5. It should be remembered that the Business Plan is primarily for the internal use of the WSSA. However, from the Business Plan EWURA can assess and benchmark the value for money of




	Water Purification and Bottling Business Plan [2024]
2.1 The Business Aqua Dreams will be a licensed and standard bottled water production company situated in an industrial area in Orleans, Massachusetts. We have been able to secure a long-term lease for a facility in a strategic location with an option of a long-term renewal on agreed terms and conditions favorable to us.




	Free Water Purification Business Plan Template + Example
Download a free water purification business plan template in PDF or Word doc format Download Now What you'll get with this template: A complete business plan Unlike other blank templates, our business plan examples are complete business plans with all of the text and financial forecasts already filled out.




	Sample Water Purification Plant Business Plan PDF [Template]
The global water purification business is worth over $60 billion (U.S dollar). Global corporations are making moves for market share in the industry. Because of the basic nature of water, access to good, healthy water is a necessity. Science and technology have come up with water purification methods and technology to ensure access to safe and ...




	Bottled Mineral Water Plant Business Plan [Sample Template]
Cost for payment of rent for 12 month at $1.76 per square feet in the total amount of $105,600. Cost for construction of a standard bottled mineral water production plant - $100,000. Other start-up expenses including stationery ($500) and phone and utility deposits ( $2,500 ).




	Sachet Water Production Business Plan [Sample Template]
1. Industry Overview Sachet or bottled water as the case maybe is one commodity that is consumed in all parts of the world and of course those that are in the business of producing sachet or bottled water, are known to generate sales year in year out if the business is well managed.




	(Pdf) a Feasibility Study Business Proposal Plan on Sachet Water
(PDF) A FEASIBILITY STUDY BUSINESS PROPOSAL PLAN ON SACHET WATER PRODUCTION IN ABUJA, NIGERIA. DEVELOPED BY BRITECH PLUS+ ENTERPRISES FOR KINNBAD INVESTMENT PLC | Awosedo Femi - Academia.edu Download Free PDF A FEASIBILITY STUDY BUSINESS PROPOSAL PLAN ON SACHET WATER PRODUCTION IN ABUJA, NIGERIA.




	BUSINESS PLAN FOR THE PRODUCTION OF PURE WATER SACHETS ...
... [Show full abstract] Request PDF | BUSINESS PLAN FOR THE PRODUCTION OF PURE WATER SACHETS AND POLYTHENE SHOPPING BAGS IN GUINEA CONAKRY | This comprehensive business plan covers the...




	Mineral Water Plant Project Business Plan, Profit Margin & Cost
By Editorial Staff November 5, 2022 Do you want to start your own mineral water plant business in India? If yes, then you have come to right place..! In this article, I am sharing step by step process of starting a mineral water plant or packaged dring water plant in India.




	(PDF) Standard Pure Water Bottled Water Business Plan In Nigeria PDF
Standard Pure Water Bottled Water Business Plan In Nigeria PDF & 2022 Financial Report David Will 2022 Our Updated sachet & Bottle water business plan is regularly updated to meet the current market prices and can also be used for loans and grants application.




	Bottled Water Business Plan [Free Template
Download Template Create a Business Plan Your bottled water business will give your clients plenty of hydration whether it uses; filtered, distilled, or natural spring water. Thus are you ready to hydrate people and start your business out of it? But before starting it you will need careful planning.




	Business Plan For a Bottled-Water Company In New York
In 2018, the industry generated a total amount of 18.36 billion dollars. According to Statista (2020), the market should grow by 8.0% from 2021 to 2025. Furthermore, the Bottled Water segment will ...




	Bottled Water Business Plan Template [Updated 2024]
Financial Highlights. [Company Name] is seeking total funding of $225,000 to open its bottled water manufacturing and distribution company. Factory design/build-out: $100,000. Equipment and supplies: $75,000. Working capital: $50,000 to pay for marketing, salaries, and lease costs until [Company Name] reaches break-even.




	Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print. To do this, you will start with baseline content in a document, potentially via a form template. Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to ...
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